
Copyright © 2013 RYAudio. All rights reserved.

Sample Librarian
User Manual

Version 1.4



Sample Librarian2

Copyright © 2013 RYAudio. All rights reserved.

Table of Contents

Part I Welcome to Sample Librarian 3

Part II Registration 4

Part III Basic working procedures 5

................................................................................................................................... 51 Getting to know the user interface

................................................................................................................................... 62 Importing samples into the library

................................................................................................................................... 83 Backing up your library

................................................................................................................................... 94 Navigating within the library

................................................................................................................................... 135 Bookmarks

................................................................................................................................... 146 The Navigation Bar

................................................................................................................................... 147 The sample list

................................................................................................................................... 198 Previewing samples

................................................................................................................................... 199 Setting sample properties

................................................................................................................................... 2210 Searching for samples

................................................................................................................................... 2311 Purging obsolete samples

................................................................................................................................... 2312 Drag 'n Drop to your DAW

................................................................................................................................... 2413 Groups

................................................................................................................................... 2614 Smart Groups

................................................................................................................................... 2915 Exporting Sample Filenames

................................................................................................................................... 3016 Tags

................................................................................................................................... 3117 Mini Mode

Part IV Configuration Options 32

................................................................................................................................... 321 The Options Dialog

................................................................................................................................... 322 Options categories

.......................................................................................................................................................... 32General settings 

.......................................................................................................................................................... 33Folders to import 

.......................................................................................................................................................... 34Audio configuration 

................................................................................................................................... 343 File Types



Welcome to Sample Librarian 3

Copyright © 2013 RYAudio. All rights reserved.

1 Welcome to Sample Librarian

Welcome to Sample Librarian, an invaluable tool for managing all of your audio samples
and helping you home in on just the sounds you want when you're in the middle of
creating your next hit.

With Sample Librarian you no longer need to waste time navigating through deeply-
nested folders of all your samples and sample CDs, which is a sure-fire way to lose your
focus (and then the moment of inspiration has gone). Instead you can use a tool designed
specifically for the purpose of managing and searching for audio samples. Once you've
found the perfect sounds for your new song, simply drag-and-drop them directly into your
DAW.

Previously, breaking off from composing to go digging through your sample collection to
find that elusive sample you know is in there (somewhere) could seriously interrupt your
creative flow. With Sample Librarian, using your sample collection now forms a key part
of your music-making process.

Key features

Manage all of your samples in one place
 

Add any number, even many thousands, of sample files (WAV, AIFF, REX, MP1/2/3, OGG
Vorbis, FLAC and WMA file formats are supported) and be able to search the library
extremely quickly in a variety of different ways.

Find samples "lightning fast"across your entire library
 

Want to quickly find and audition all "moog" or "TB-303" samples you may have,
irrespective of what sample CD they came from or where on your hard drive they exist?
Simple and "instant". Find all samples of a given file type, bit depth, sample rate (or
combination thereof) and many more options.

Get organised 
 

Create Groups of samples that you would like to keep listed alongside each other, even
though they are scattered across various sample CDs within your library. The original
files remain where they are, but any number of new relationships can be created to help
you organise your samples the way you want them. Alternatively, create Smart Groups
that organise samples automatically based upon rules that you define. Or use Tags to
organise samples by any number of categories you choose (Genre, Sample Type, etc.).

Add information to remind yourself of previous decisions 
 

As you're auditioning samples you may find some choice examples that you want to
remember in a future session, but may not be what you're looking for right now. But
with thousands of samples in your library, how are you going to remember what was so
great about this one? Before you move on, quickly add a "4 star" or "5 star" rating and a
comment ("This would be perfect for a bouncy house groove") to remind yourself at a
later date.

Get your money's worth from those sample CDs! 
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Sample CDs aren't cheap, but often they sit languishing on your hard drive simply
because you don't have an easy way to audition their contents and make use of them.
You may already have the perfect sample or loop to really polish your latest song but if
you can't find it, it's not worth having. Sample Librarian makes using your sample
library easy, efficient and fun.

2 Registration

When you first run Sample Librarian, and until such time as you have purchased a
license and registered your copy of the software, it will run in "trial mode". This is a fully
functioning version of the application, so that you can try out all of the features, but is
restricted to run for 30 days since the date of installation. You will see the following
dialog whenever you run the application in trial mode:

If you find the application useful and decide to purchase a license (from the RYAudio Web
site at http://www.ryaudio.com) you will be sent a serial number via e-mail which you can
enter in the "Serial number" field and then click "Register". If the serial number is valid
then the application will be registered to you and the trial notification will no longer
appear.
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3 Basic working procedures

3.1 Getting to know the user interface

The Sample Librarian screen is divided into three main sections, as shown in the
screenshot below.

1. Library Navigator

The Library Nav igator is a folder-based way of navigating through your sample collection,
similar to the way you organize files within Windows Explorer. How you use this to
navigate through your samples (and why there is a crucial difference between the
approach used in Sample Librarian and that of Windows Explorer) is discussed in more
detail here.

2. Sample List

The main part of the window is taken up by the list of samples. This will either be your
complete sample list or, more likely, a subset based on your current search criteria. The 
Sam ple List is discussed here.

3. Sample Preview

At the bottom of the screen there is a preview window that shows a visual representation
of the currently selected sample's waveform, to help visually identify the sample's
content. There is also a VU meter that displays the output level in real-time.
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3.2 Importing samples into the library

When you first start the application the sample library will be empty. Before you can make
use of the functionality within Sample Librarian you therefore need to import some
samples.

But before we do that, it is important that you understand some key aspects of how 
Sample Librarian works.

How Sample Librarian manages your library

When Sample Librarian scans your hard-drives looking for samples, it imports information
about them (name, duration, sample rate, bit depth, etc.) into its own database and
stores links back to the original files on disk. The library is therefore a form of index
enabling you to locate the sample files, just like a card index would enable you to locate
books in a real library. 

So there's a potential "gotcha" that you need to be aware of. Because these are only
links to the files, and not the files themselves, you need to be careful to avoid these links
becoming 'broken' (i.e. a link points to a location but the file isn't there anymore). This
can happen for a few reasons; if (outside of Sample Librarian) you delete the file from
your hard-drive, rename it or move it to another location. Just the same as if you moved
a book in a real library; the card index becomes out of date for that record and refers you
to a shelf on a floor in the library where the book no longer resides.

Another important concept to bear in mind is that you can add additional information
about each sample (like comments and ratings) within Sample Librarian itself. This
information is stored within the library, not the underlying file. That means if you delete
the record from your library, but leave the file on your hard-drive, you will have lost the
information you added within Sample Librarian. You could reimport the sample again, and
it would retrieve the core properties of the file (name, sample rate, etc.) but those
additional comments and ratings would have been lost.

So how do you avoid such broken links? The simple answer is that once you have
imported samples into Sample Librarian you should try to avoid renaming them or moving
them, or renaming/moving the folders they reside in. On the other hand, if you delete
samples from your hard-drive you can use the "Purge obsolete samples" facility to identify
them and remove the redundant links from your library.

With all this in mind, we can now look at how to import samples into the library in the first
place.

Your first import

To tell Sample Librarian where to find your sample files you need to bring up the
"Options" dialog by choosing "Tools ... Options" from the main menu, or by clicking on the 

 button on the toolbar.
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On the "Folders" tab you can specify a list of folders on your hard drive where your
samples are held. For example:

C:\My Main Sample Library
C:\Temporary Sample Downloads
D:\Sample CDs
E:\MP3 Files

You only need to specify the top-most directory in each case as Sample Librarian will
automatically scan within the sub-directories beneath the directories you specify.

NOTE: You could simply enter the root directories of each of your hard drives ("C:\", "D:
\", and so on) but this would slow down the import process significantly as your entire
hard drive would be scanned every time you asked Sample Librarian to update the
library.

Once you have specified the folders to search, click the "OK" button to return to the main

window, then choose "Scan for Samples" from the "File" menu, or click on the  button
on the main toolbar.

Sample Librarian will now scan the folders you specified, looking for the individual sample
files within those directories and adding them to the sample library. When the process has
completed (and it could take some minutes, depending on the number of directories and
the number of files within them) the scan window will close and you will return to the main
window. Assuming at least one sample file was found the Sample List will now contain a
row for every sample in the library.

For more details on how to specify the folders to import, click here.
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Adding more samples (re-importing)

So you've imported your entire sample library into  Sample Librarian, but then a few
weeks later you buy another sample CD and copy it onto your hard-drive with all the
others. How do you add those new samples into Sample Librarian?

There are two ways you can do this. The simplest (but slowest) way is to choose "Scan
for Samples" again (either from the menu or the toolbar) and perform another complete
scan. As long as the new files are within the directories you specified to look for samples
they will be found and imported.

However, as your library grows bigger you will find that performing a full scan every time
takes rather a long time. You can therefore choose just to refresh from a particular folder,
if you already know where the new files are located. To do this, click on the relevant
folder within the Library Navigator (the panel on the left) then choose "Rescan from
selected folder" from the "File" menu, or right-click on the folder and choose "Rescan from
here". You can also right-click in the Sample List (if you are currently viewing the
contents of a folder) and choose "Rescan from here".

3.3 Backing up your library

Before we move on to look out how to use your newly created library, a word of warning
- it is imperative that you make a habit of regularly backing up your library.

This is very simple, as there are just two files that you need to backup:

SampleLibrarian.db3 - this is the library itself, and may be quite large depending on
how many samples you have imported

SampleLibrarian.ini - contains your configuration settings, and is important to backup
as it enables Sample Librarian to work with your library file correctly

These files can be found in one of the following locations, depending on which version of
Windows you are running:

Windows XP - C:\Documents and Settings\your_username\Application
Data\RYAudio\Sample Librarian\

Windows Vista/Windows 7 - C:\Users\your_username
\AppData\Roaming\RYAudio\Sample Librarian\

Please replace "your_username" in the above paths with the username you use to logon to
your PC.

So, to reiterate, please ensure you backup these files regular ly and especially after
making significant edits within Sample Librarian (adding comments or ratings to samples,
creating Groups or Smart Groups, and so on).

NOTE: You m ust ensure you close Sample Librarian before backing up these files,
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otherwise there is the risk that important information will not have been saved correctly
at the time you copy the files.

3.4 Navigating within the library

On the left-hand side of the main window you will find the Library Nav igator pane. This
contains a hierarchical tree which organizes your samples by various categories.

It's important to understand that a sam ple c an appear in m ore than one c ategory! This is
a crucial point, and therefore deserves a little more explanation...

Virtual folders

Although the Library Nav igator looks similar to the Windows Explorer folder tree (that you
will almost certainly be familiar with) there is a fundamental difference in the way the two
operate.

In Windows Explorer a file can exist in only one folder at the same time. You can make a 
c opy of that file in another folder, of course, but then you have two separate files that
just happen to have the same content (and if you edit one then they will have different
content).

In Sample Librarian, however, the Library Nav igator contains what you might want to
think of as "virtual folders", that actually act as searc hes within the sample library. For
instance, the "mono" folder within the "Format\Channels" folder will 'contain' all of the
samples that are monophonic (as opposed to stereo). However, some of those same
samples may also appear in, say, the "WAV" folder within the "Format\File type" folder,
which 'contains' all of the samples with a ".WAV" file extension. Likewise, if you flagged
one or more of those samples as having a 5 star rating, then they would also appear in
the "Rating\5 stars" folder, and so on.

The library folders
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The Library Nav igator organizes your samples into different folders, as detailed below.
Note that the last folder you select, as well as the branches of the folder tree that you
have expanded or contracted, will all be remembered so that they are the same for the
next time you launch the Sample Librarian application.

Locations

This folder provides a way to navigate through your library hierarchically based on the
location the samples are physically located on your hard drives. Sounds just like Windows
Explorer, right? Yes, but even here Sample Librarian has a trick up its sleeve; the
Locations folder contains special items labeled "All from here":

Clicking on one of these will show all samples in that folder and all of the sub-folders. So if
you know a sample is somewhere in a particular path, but you can't recall in exactly which
sub-folder, simply click on "All from here" within a higher level folder and you can then
browse all of the samples as if they were in the same folder.

This is just one example of how the "virtual" nature of folders in Sample Librarian can
make finding samples much easier.

Note: For a quick way to rescan just a portion of your library you can right-click on a
folder and choose "Rescan from here". See the topic on importing samples for full details.

Format

The sub-folders within this folder let you filter the samples within your library based upon
their file format:
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The following folders are available:

Channels — e.g. mono, stereo or surround-sound

Bits — e.g. 8 bit, 16 bit, etc.

File Type — e.g. AIFF, WAV, ReCycle, etc.

Sample rate — e.g. 44.1 kHz, 48kHz, etc.

Rating

One of the many nice features of Sample Librarian is the ability to give samples a rating,
so that you can remind yourself that this particular "909 kick" sample is better (or worse)
than the other 100 similar 909 kick samples in your library. That way you can home in on
the samples you've already previewed and decided are the cream of the crop, while
avoiding those you know aren't as interesting.

The first five folders "5 stars" through to "1 star" will show only those samples with that
particular rating. "Any rating" will show all samples that have had a rating assigned,
irrespective of the number of stars (that is, any sample that you've made a judgement
on). Conversely, "Not rated" lists all samples that you have not yet applied a rating to.
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History

The History folder is primarily for finding samples you've recently listened to (see "
Previewing samples" for more information). This is to get around that problem where you
know you heard the perfect sample a few days ago that would work just right in your
current project, but you've no idea what it was called or which of your sample CDs it was
on. Simply click on the "In the last week" folder and you'll see a list of all the samples
you've previewed in the last 7 days. Run down the list until you hear that elusive sample
and presto... drag it to your DAW and you're back to music-making.

The first few folders collect samples based on different timelines, from "This
session" (samples previewed since you launched this latest session of the application)
through to "In the last month".

The "Never previewed" folder shows just that - samples that you have never clicked on to
preview within Sample Librarian.

Finally, the "Recently added (this session)" and "Recently added (last 7 days)" folders
show files that have been added to the library by scanning/re-scanning your sample
folders during this session or in the last 7 days respectively.

Tags

Tags provide a way to categorise samples based on any number of criteria you choose,
such as Genre (Pop, Electronic), sample type (Drum Hit, Loop) and so on. The Tags folder
lists all of the tags you have defined, and clicking on a given tag will show all samples
that have been catalogued with that tag. See the section on Tags for more details.
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Groups

Groups are a way to maintain selections of samples that you wish to hold as a collection.
For more information see the dedicated topic on the Groups feature.

Smart Groups

Smart Groups are an automated approach to Groups where, instead of choosing the
individual samples to add, a set of rules is used to automatically determine which samples
will be included. This is discussed in a dedicated topic on Smart Groups.

3.5 Bookmarks

Any location within the Library Navigator pane's folder hierarchy can be added to a list of
bookmarks, which you might also think of as a list of "favorite locations" you wish to
remember. You can then quickly jump to these bookmarked locations at a later date
without having to navigate through the hierarchy. Bookmarks are especially useful when
working in the 'Mini Mode' view, where the Library Navigator pane is unavailable.

The options for working with bookmarks, as well as the list of bookmarks themselves,
appear in the "Bookmarks" menu and are also available from the toolbar by clicking on the
bookmark icon:

'Add Bookmark' will add a new entry to the list of bookmarks, linking to the currently
selected folder in the Library Navigator pane

'Edit Bookmarks' will open a new dialog to enable you to rename, delete or reorganise
the list of bookmarks. There is also an option to delete any bookmarks that no longer
point to valid locations within the folder hierarchy (i.e. if you have bookmarked a
location and then subsequently reorganized your sample library and performed a
rescan).

Note that for convenience the first ten bookmarks are also accessible via keyboard
shortcuts (ALT+1 to ALT+0), so you will generally want these to point to the locations
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you use the most often.

3.6 The Navigation Bar

Directly above the Sample List you will see the Navigation Bar, which provides a number of
additional features for moving around your sample library.

From left to right the Navigation Bar contains the following:

Your current location within the library (that is, the folder you currently have selected
in the Library Navigator) which is separated into individual folder names separated by
small arrows. Clicking on any of these underlined folder names will jump directly to that
location. In this way you can jump back any number of levels along the current path.

The left and right arrows are "back" and "forward" buttons which navigate backwards
and forwards respectively through your browsing history. This can be very useful when
you use features such as bookmarks to jump to different locations.

The up arrow takes moves back up one folder in the hierarchy (the same as clicking on
the underlined folder second from right in the path list).

3.7 The sample list

When you have selected a folder within the Library Navigator you will see a corresponding
selection of samples listed in the main part of the Sample Librarian window. This is
called the Sam ple List window.
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Columns within the Sample List

The Sam ple List provides a number of items of information for each sample, listed in
columns across the window:

The sample name (e.g. "Techno Kick" or "Deep Moog Bass"). This is the sample's
filename without the file extension (.wav, .aif, etc.) because this is shown separately in
the "Extension" column (see next).

The extension (e.g. wav, aif, mp3, rx2) extracted from the sample's filename. This is
strongly related to the sample's "file type" which is shown in the next column and is
actually somewhat more useful (because some file types can have multiple file
extensions associated with them, such as .rcy and .rx2 extensions both being Recycle
files). For this reason the Extension column is hidden by default (see below for how to
customize which columns are visible).

The file type (AIFF, WAV, ReCycle, etc.)

The number of channels (mono, stereo or surround sound)

The number of bits (8 bit, 16 bit, 24 bit, etc.)

The sample rate (44.1 kHz, 48 kHz, etc.)

The tempo (e.g. 120 bpm), available for certain file formats (REX and "Acidized" WAV
files)

The time signature (3/4, 4/4, etc.), available for certain file formats (REX and
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"Acidized" WAV files)

The root note (C, C#, D, etc.) available for some "Acidized" WAV files

The duration (e.g. 6 seconds)

The file size (in physical storage rather than length of time)

The date and time the file was last modified on disk, such as from edits made within
an audio editor. Note that this does not include updates within Sample Librarian such
as changing the rating or adding a comment; these are updates to the data held within
the library, rather than to the file itself.

A rating, from 1 to 5 stars, that you can apply to the sample from within Sample
Librarian

A comment, such as "Great kick sample - consider for next song", which you can apply
from within Sample Librarian

The file path; that is, the location on the computer where the file is physically stored
(e.g. C:\Samples\FX)

Customizing columns

You can customize the Sam ple List display in a number of ways to suit your particular
style of working.

First, you can choose to hide individual columns (except the Name column, which must
always remain visible) if they are not currently of interest to you. Right-click on any
column heading and a list will appear with an entry for each column that can be displayed.
Click on one of the column names to hide it. Click again to redisplay it.

You can also change the order in which columns appear. To do so, left-click and hold on a
column name, then drag it to the new location where you would like it to appear.
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Finally, you can change which column is used to sort the list by clicking once on a column
heading. This will change the list to be sorted, in ascending order, by that column. Click
again for descending order.

Note that all of these settings will be stored so that they will be the same the next time
you launch the Sample Librarian application.

Selecting samples in the list

You can select one or more samples in the Sam ple List that you want to perform actions
on (see below). Following the standard convention for multiple selections in Windows
applications, to select more than one item do one of the following:

Click on the first item, then hold down the SHIFT key and click on the last

Hold down the CTRL key and click on items to add or remove them from the current
selection.

The context menu

If you right-click on any of the samples within the Sam ple List a menu will appear showing
the possible actions you can perform on the selected sample(s).
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Play - let's you preview the sample to hear what it sounds like

Stop - cuts off the currently playing sample

Add to Group - lets you add the sample(s) to a Group (see the section on Groups for
more information)

Remove from Group - if you are currently browsing the contents of a Group then this
will remove the selected sample(s) from that Group (see the section on Groups for more
information)

Set Rating - lets you assign a rating to the sample(s), from 1 star (very bad) to 5 stars
(very good). You can also remove a rating by setting it to no stars.

Set Tags - lets you assign one or more tags to the sample(s), such as Genre\Pop or
Genre\Dance. You can also remove a tag that had previously been assigned.

Rescan from here - For a quick way to rescan just a portion of your library you can
choose this option (if you are currently viewing the contents of a folder in the
"Locations" tree). See the topic on navigating with the library for details.

Locate in Library Navigator - will jump to the relevant folder under the "Locations"
node in the Library Navigator so that you can see the sample alongside other samples
that exist in the same folder

Show in Windows Explorer - will launch Windows Explorer and navigate to the folder
where this sample is located

Copy sample path to Clipboard - will copy the full path and filename of the sample to
the Windows Clipboard for use in another application (e.g. in an Open Sample dialog for
an application that doesn't support Drag 'n Drop operations)

Launch associated editor - executes whichever application is configured on your
computer to handle the file type of the file you have selected (or an application of your
choice, which you can set by choosing Tools...Options), passing the filename of the
current selection
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Properties - opens a dialog to let you set certain properties for the sample in one go,
such as a comment, rating, and so on.

3.8 Previewing samples

Clearly, to find the samples you are after you need some way of auditioning them. 
Sample Librarian lets you do this in one of two ways:

Click on a sample in the Sam ple List and then select the "Play" option, which is available
in multiple places (and in each case there is an equivalent "Stop" command to cut off
the currently playing sample):

o Click on the "Play" menu and choose the "Play" option within it

o Right-click on the sample and choose "Play" from the context menu

o Click the  icon on the toolbar

o Press the Space key on your keyboard. You can also press the Escape key to stop a

playing sample.

For convenience you can instruct Sample Librarian to automatically preview samples
whenever they are selected in the Sam ple List.

o Click on the "Play" menu and the "Auto Preview" option. Selecting it again will turn

Auto Preview off.

o Click the  icon on the toolbar to toggle the Auto Preview status on/off

You can also select whether you would like samples to be previewed once when you press
play, or play repeatedly in loop mode (when playback reaches the end of the sample it will
loop back to the beginning and continue). To do so click on the "Play" menu and choose
"Loop" or click the loop icon on the toolbar. You can also turn loop mode on/off using the
keyboard shortcut CTRL+L.

3.9 Setting sample properties

The intrinsic properties of each sample file (the file type, sample rate, bit depth, and so
on) are automatically retrieved by Sample Librarian when it scans for files to add to the
library (for details on this process see the section on importing samples).

However, you can also add additional information for each sample within Sample
Librarian itself, specifically:

A rating, from 1 star (very bad) to 5 stars (very good) to so that you can remind
yourself that this particular "909 kick" sample is better (or worse) than the other 100
similar 909 kick samples in your library. That way you can home in on the samples
you've already previewed and decided are the cream of the crop, while avoiding those
you know aren't as interesting.

A comment, such as "Great kick sample - consider for next song" which, again, can be
used to help you remember things about this sample for the next time you see it in the
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library.

Any number of tags such as a particular Genre (Pop, Electronic, etc.) or Sample Type
(Drum Hit, Loop, etc.)

There are a number of ways that you can edit these additional properties within Sample
Librarian which are detailed below.

Setting a sample's rating

To set or change a sample's rating, select it (or select a number of samples
simultaneously to update them all to the same rating) then do one of the following:

Click on the "Edit" menu, then "Set Rating", then choose a rating to apply (or "None" to
remove a previous rating)

Right-click on the sample(s), choose "Rating" then choose a rating to apply

Click the  icon on the toolbar and choose a rating from the list that appears

Use the Sample Properties dialog discussed next

Assigning tags to sample

This topic is discussed in detail in the section on Tags.

The Sample Properties dialog

To add a comment you need to open the Sample Properties dialog for the selected sample
by doing one of the following:

Click on the "File" menu and then choose "Properties"

Right-click on the sample and choose the "Properties" option from the context menu
that appears

Click the  icon on the toolbar
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This dialog shows you all of the fixed (i.e. non-editable) properties for the sample - the
file name, path, file type, sample rate, and so on - and then lets you edit the rating
(discussed above) and also a textual comment. There is also a separate tab for editing
the Tags assigned to this sample.
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Once you have entered or amended these, click OK to save the details to the library, or
cancel to exit back to the main screen without saving the changes.

3.10 Searching for samples

One of the easiest and fastest ways to locate samples within your library is to use the
text search facility, which you can find on the toolbar at the top of the main window.

To perform a search, click in the entry box to the right of the word "Find:" (or press and
hold the CTRL key and then press the F key to automatically place the cursor in the
search box) then type the word or combination of letters that you are looking for. For
instance, if you want to find all of your kick drum samples, you might perform a search for
"kick" or "kick drum".

To perform the search, click the "Go" button, or simply hit the ENTER key on your
keyboard. The Sam ple List will then change to show all sample files within the library that
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contact that search text within the sample name, or the file path where the sample is
physically stored.

You can specify whether searches look for matches across all text columns or just in the
name, path or comment columns. This setting is selected via the drop-down list next to
the search text box, and is saved across sessions.

Tip: If there is a particular search query you would like to perform repeatedly, you might
want to create a Sm art  Group using that search text as a custom rule. For details on how
to do this, please refer to the section on Smart Groups.

3.11 Purging obsolete samples

Choosing this option from the "File" menu will invoke a Wizard that will walk you through
the process of purging your library of "obsolete" samples.

What are obsolete samples? When  Sample Librarian scans your hard-drives looking for
samples it imports information about them (name, sample rate, bit depth, etc.) into its
own database and stores links back to the original files on disk. The library is therefore a
form of index enabling you to locate the sample files, just like a card index would enable
you to locate books in a real library.

Sometimes, these links can become 'broken' (the link points to a location but the file isn't
there anymore). This can happen for a few reasons; if (outside of Sample Librarian) you
delete the file from your hard-drive, rename it or move it to another location. Just the
same as if you moved a book in a real library; the card index becomes out of date for that
record.

There is another form of obsolete record too, which can occur if you change the list of
directories that you want Sample Librarian to scan for samples (in Tools...Options). For
instance, if you were originally scanning 3 folders, then decided you were no longer
interested in the third and removed it from the list, Sample Librarian's library would still
contain links to all the samples in that folder. In this instance they would be valid
references (the files do exist where the index says they should be) but you have decided
you no longer want them in your library's catalogue.

This Wizard therefore enables you to remove both types of obsolete samples from your
library: those records that point to missing files, and those samples that are now outside
the folders you have chosen for Sample Librarian to scan.

To scan for obsolete files, click the "Next" button. You will then be shown a list of any
samples that need to be purged, but will have the chance afterwards to decide whether
or not to remove them from the library.

3.12 Drag 'n Drop to your DAW

Sample Librarian provides a central location to manage all of your samples and a variety
of ways to find just the samples you're interested in within that library - no matter how
large or unwieldy (if you weren't using Sample Librarian, that is) it grows.
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But once you've found the perfect sounds for your new song, what next? With Sample
Librarian it's as simple as dragging and dropping them directly into your DAW.

To do this, set up your screen so that the Sample Librarian window is floating on top of
your DAW's window, and so that the two are visible at the same time. Then, left-click and
hold on a sample within the Sam ple List and then drag it over to the timeline (or whatever
is appropriate for the receiving application) in your DAW and release the mouse button.

 

Important Note: This feature may not work in all DAW applications, as not all support
Windows Drag-and-Drop operations. For instance, Propellerheads Reason does not allow
samples to be dropped onto its interface (either from Sample Librarian or from any other
application, such as Windows Explorer). However, a fair number (such as Cockos Reaper,
shown in the example above) offer this.

3.13 Groups

Groups are a way to maintain collections of samples that you wish to hold as a group. For
instance, samples you want to try for a particular song you're working on. They appear
within the Library Nav igator under the "Groups" folder.
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Samples can be in any number of Groups, not just one, as Groups merely hold references
to the individual samples within them (see the description of Virtual Folders for more on
this concept).

Creating Groups

To create a Group, do one of the following:

In the "File" menu choose the "New Group..." option

Right-click on the "Groups" folder within the Library Nav igator and choose "New
Group..."

Right-click on one or more samples within the Sam ple List, then choose "Add to Group"
from the context menu and select the "New Group..." option

Click on the  icon on the toolbar

Whichever of these you choose, you will then see a dialog asking for you to provide a
name for the new Group.

Editing Groups

To edit the name of a Group do one of the following:

Right-click on the Group name then chose "Edit Group..." from the context menu

Click on the Group name and then press the F2 key

Adding samples to Groups

To add samples to a group, select one or more samples in the Sam ple List, then right-click
on one of them and choose "Add to Group" from the context menu.
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From the drop-down list select the name of the Group you want the samples to be added
to.

Removing samples from Groups

To remove samples from a group, first select the relevant group in the Library Nav igator
then select one or more samples in the Sam ple List and do one of the following:

In the "Edit" menu choose the "Remove from Group" option

Right-click in the Sample List and choose "Remove from Group" from the context menu

Deleting Groups

To delete a Group, right-click on the Group name then chose "Delete Group..." from the
context menu.

More advanced Groups

For an automated approach to defining Groups, using a set of rules to determine the
samples that are included, you can use Smart Groups.

3.14 Smart Groups

Sm art  Groups are an automated approach to Groups where, instead of choosing the
individual samples to add to a Group, a set of rules is used to automatically determine
which samples will be included. They appear within the Library Nav igator directly after the
"Groups" folder.

A selection of example Smart Groups are automatically created for you when the
application is installed. Once you have imported some samples into your library you can
try these examples to quickly get an idea of the kind of thing you can accomplish with
Smart Groups.

For example, you can build Smart Groups that automatically group samples based on their 
file type, sample rate, rating, and so on. You can also combine a number of such criteria
to narrow down the type of samples you are looking for.

Creating Smart Groups

To create a Smart Group, do one of the following:

In the "File" menu choose the "New Smart Group..." option

Right-click on the "Smart Groups" folder within the Library Nav igator and choose "New
Smart Group..."

Click on the  icon on the toolbar
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Whichever of these you choose, you will then see a dialog asking for you to specify the
name and rules for the new Smart Group.

Defining the rules for your Smart Group

Smart Groups work by using a set of rules, that you define, and applying them as a filter
across your entire sample library. Each rule is comprised of three elements:

A column to search or filter on (e.g. the sample name, number of channels, sample
rate, rating, bit depth, and so on)

Next is the type of filter operation to apply to that column (equals, doesn't equal, is
less than, is greater than, and so on). The operations available will reflect the column
chosen because operations like "is greater than" would not make sense for a text-based
column like "Sample Name", but would make sense for a numeric column like "File size".
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Finally, you need to specify the value to compare against (is greater than what?) or in
some cases, like the "is in the range" operator, you will need to specify two values
("rating is in the range 3 stars to 5 stars", for instance)

You can define more than one rule for a Smart Group, up to a maximum of 10 rules. To
add additional rules click the "Add Rule" button. To remove them, click on the cross to the
right of an individual rule.

Finally, you can specify whether all of the rules need to match for a given sample to pass
the Smart Group filter, or whether any rule is sufficient.

A working example

As that's quite a lot to take in, here's a (slightly contrived) example that illustrates the
types of filters you can create using Smart Groups.
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This filter would match all samples with "FX" in the name, with a rating over 3 stars,
where the duration is between 5 and 10 seconds, looking only for stereo samples and
those that have been previewed (in Sample Librarian) within the last 7 days.

So you might call that Smart Group "Good medium-length stereo FX samples I've
previewed recently" perhaps.

Editing Smart Groups

To edit an existing Smart Group's name or rules do one of the following:

Right-click on the Smart Group name then chose "Edit Smart Group..." from the context
menu

Click on the Smart Group name then press the F2 key

Double-click on the Smart Group name

Deleting Smart Groups

To delete a Smart Group right-click on the Smart Group name then chose "Delete Group/
Smart Group..." from the context menu

3.15 Exporting Sample Filenames

By using Groups and Smart Groups you are able to collect together samples that have
relevance for you, but they may be scattered across your hard-drive in any number of
different folders. This is the power of Groups, after all.

But if you are using other software or scripting tools to work with such samples, it can be
useful to output the list of samples to a text file, complete with their fully qualified path
and filenames.

To do this, right-click on a Group or Smart Group name in the Library Navigator and
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choose the menu item "Export Sample Filenames...". You will be asked to specify the name
and location of the text file to output to, and then the file will be exported.

3.16 Tags

Aside from adding samples to Groups or creating dynamic searches via Smart Groups, you
can also organise your samples using the tagging features of Sample Librarian.

For example, you may want to apply tags to samples to indicate which Genre they would
suit (Rock, Pop, Dance, etc.) or by the Type of sample (Drum Hits, Synth Loops, etc.).

Tags are grouped into categories to form a 2-level hierarchy. In the examples above,
"Genre" and "Type" are categories and "Rock", "Pop", "Dance", "Drum Hits", and "Synth
Loops" are the actual tags. Sample Librarian comes with a number of tags and
categories already defined, but you are free to edit or delete these and add new ones as
best suits your needs.

Assigning tags to samples

To set or remove tags from a sample, select it (or select a number of samples
simultaneously to apply the same changes to them) then do one of the following:

Click on the "Edit" menu, then "Set Tags", then choose a tag from the list of categories.
If the sample has not previously had that tag applied it will be added, otherwise it will
be removed. A check mark against a tag shows that the sample has already been
assigned that tag. For multiple selections none of the samples will show check marks
and choosing one will ask whether you want to add it or remove it from all selected
samples.

Right-click on the sample(s), choose "Set Tags" then choose a tag to apply

Click on the tag icon on the main toolbar

Bring up the Sample Properties dialog where you can also edit a sample's tags

Creating new tags and categories

When you add tags using one of the methods listed above (except for via the Sample
Properties dialog) you will notice that at the top of the list of tag categories there is the
option to create a new category. Similarly when you click into any of the categories to
see the tags within it, there is an option at the top of the list to create a new tag.
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You can also create new categories and tags by right-clicking on items within the "Tags"
folder in the Library Navigator.

Renaming or deleting tags and categories

Tags and categories can be renamed or deleted by right-clicking on them in the Library
Navigator and choosing the appropriate menu option.

3.17 Mini Mode

When you launch Sample Librarian it will always start up showing the full user interface,
however there is an alternative mode that shrinks the application down to a minimal
display of just the current sample list. This is called the "Mini Mode" and you can switch
between the full display and Mini Mode by pressing the F12 key (or by clicking on the
relevant toolbar button or by selecting the "Switch Mini/Full Mode" item within the View
menu).
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The primary purpose of Mini Mode is for when you are ready to drag 'n drop samples to
your DAW, but find that the full Sample Librarian display gets in the way. Instead of
moving and resizing the window to be able to see both your DAW and Sample Librarian
simultaneously, you can simply press F12 and Sample Librarian will shrink down to Mini
Mode and move to the right-hand side of the screen giving you easy access to both
applications. Also, in Mini Mode Sample Librarian will automatically stay floating on top
of all other windows, even if you switch focus to another application (i.e. it can't
accidentally get hidden behind your DAW, forcing you to press ALT+TAB to bring it back
on top again).

Note that you may find the Bookmarks features especially useful when working in the "Mini
Mode", as the Library Navigator pane is unavailable.

4 Configuration Options

4.1 The Options Dialog

There are a number of options that can be set that customise the way the Sample
Librarian application operates. You access these by selecting the "Tools" menu and then

clicking "Options...". Alternatively you can click on the  button on the Toolbar.

The Options dialog splits the various configuration options into a number of categories
shown on separate tabs:

General settings

Folders to import

Audio configuration

4.2 Options categories

4.2.1 General settings

The "General" tab lets you specify which application is launched when you choose the
"Launch associated editor" option for a selected sample. You can either leave this at the
default option, which will launch whichever application is associated with that file type in
Windows, or you can specify an application that you would always like to use.
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4.2.2 Folders to import

The "Folders" tab in the Options dialog holds important settings that specify which folders
on your computer you want Sample Librarian to examine when scanning for sample files
to import into the library.

For more details on the import process and how these settings are used, look here.
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4.2.3 Audio configuration

The "Audio" tab in the Options dialog is where you specify which sound card to use when 
previewing samples within the Sample Librarian application.

The "Audio device" drop-down list shows all devices available on your system. Select one
of these and click "OK" for it to take effect.

4.3 File Types

Sample Librarian can import samples of a number of different file types (e.g. WAV, AIFF,
OGG Vorbis, FLAC, WMA). You can view the list of file types by clicking on the "Tools"
menu and selecting the "File types..." menu item.

This form contains two tabs; the first shows the list of built-in file types and the second
shows any 'custom' file types that you have added.

Built-in file types

Built-in file types are those that Sample Librarian 'understands' and can therefore import
detailed information from. You can also preview files of these types from within the
application.
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You cannot add to or remove entries from the built-in types, but you can disable
individual types if you are not interested in them being imported into Sample Librarian.
Please note that if you disable a file type and you have previously imported samples of
this type, they will be removed from your library when you disable it. If you have added
comments, ratings or tags to these samples that information will therefore be lost.

Custom file types

Custom file types allow you to use Sample Librarian to catalogue files that it does not
natively support, but for which you would like to use the same cataloguing, grouping,
tagging, search and drag-and-drop facilities - but without the ability to preview the files
directly within Sample Librarian.
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For example, if you are a user of FL Studio (a DAW created by Image-Line) then you
might decide to add FL Studio's own preset format (files with the extension '.flp') so that
these are imported into your library in addition to your samples. You obviously won't be
able to preview these files within Sample Librarian as the application is unable to launch
the relevant FL Studio instrument plugin to play the preset. However, you will still be able
to use all of the powerful cataloguing and searching features of Sample Librarian just
like you do with samples. You will also be able to drag-and-drop FL Presets directly onto
FL Studio itself which w ill add the relevant instrument plugin and load the relevant preset
in one action.

Other examples might be Native Instruments Kontakt presets, or presets for other plugins
that support drag-and-drop (you'll need to use a bit of trial and error to determine which
do support this and which don't).
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